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Univeral Design for Learning (UDL) at NECC
A unique experiment, with three areas of focus: 
Accessibility, Text Design, and Increased use of Images

1. Accessibility
For course materials, compliance with the Ameri-
cans With Disabilities Act (ADA) involves a check-
list that we recommend for faculty and staff. 

Provide multiple format options
Let students choose from 
print, PDF, video, slide 
shows, etc. Post a digital 
version of course materi-
als in Blackboard in case a paper copy is lost, or 
someone wants to hear the text with ear-buds.

Tagged headings with Quick Styles
People who are blind use screen readers to convert 
text to speech 
(TTS). Tagged 
headings allow skip 
navigation, jumping 
from one heading 
to another. We 
teach faculty to use Quick Styles in Word, adding a 
special tag to a title, heading one, heading two, 
bullet list, caption, etc.

Alternate text for images
“Alt tags” can be added in Word, providing a de-
scription of the teaching content of an 
image for students who are blind.

Accessibility Checkers
In Word’s Review tab, the first tool is 
“Check Accessibility.” It will list the fixes needed for 
ADA compliance.

Blackboard’s Ally’s automatic checker uses a 
meter icon to measure acces-
sibility of uploaded documents 
and videos. When faculty 
make changes, the needle moves into the green 
zone.

Closed captions required
All videos must have closed captions. 
These are useful to everyone, not only 
deaf and hard of hearing.

2. Text design—legible, Inclusive
Faculty are being trained in basic graphic design 
using Word. The emphasis is upon being legible and 
user-friendly for a broad range of abilities—not just 
people with disabilities.

Double columns
In Word’s Layout tab, use the dou-
ble-column tool. Short lines are easier 
to read, especially on smart phone 
screens.

Chunking of text
Divide text into chunks with numbers, 
bullets, subheads, line space, or rules. 
Avoid adding borders to text boxes 
because they can complicate navigation 
for screen readers.

Larger type sizes
Increase text size when possible to 12, 
13, 14, or even 16 point. Large type helps 
readers with vision impairments, and is 
less intimidating for readers with low literacy skills.

Legible fonts
For body text, stay with 
simple, sans-serif fonts 
that have monoweight 
strokes. Serif fonts with 
tapered strokes, like 
Times Roman, are familiar, 
but cause eyestrain for 
many readers, especially those with astigmatism. 
This text is set in Gill Sans.

Lance Hidy
Accessible Media Specialist

Kristen Sparrow
Faculty, Computer Science
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3. Increased Use of Images 
The use of images 
has always been a 
foundation princi-
ple of UDL. 
Psychologists who 
study the science 
of learning, like 
Richard E. Mayer 
(right), author of 
Multimedia Learn-
ing, have proved 
that people learn 
better when 
content is deliv-
ered through 
words and images 
together. 

However, out-
side of art schools, 
academics are 
rarely taught how to 
communicate with images. But now in the age of 
smart phones with cameras for still and video 
photography, educators are suddenly realizing that 
images can be a powerful tool for reaching stu-
dents, and their phones provide the means to do it. 

How do we start to bring visual literacy into 
academia? At NECC, the development of the icon 
system for our academic departments has provided 
an easy entry point for faculty and staff to start 
learning how to incorporate images into their 
documents.

We provide training in how to find effective icons, 
how to build an image library, and how to insert 
and unlock images so they can be moved freely on 
the page in Word.

 

 

Forensic Science Syllabus (SCI130-TR) 
Northern Essex Community College 

Spring Semester 2019 
 
 

Instructor 
Information  
Dr. Mike Cross 
Email:  
mcross@necc.mass.edu 
Phone:  978-556-3362 
Office:  E256 
    

Course Location & Time 
Lecture      Haverhill E260 
Tuesday, Thursday    12:30 – 1:45 pm 
 
Lab            Haverhill E255 
Thursday     9:30 – 11:10 am 
        

Course Description 
This course will introduce students to modern 
criminal investigative techniques through hands-
on laboratory experience.  Topics include 
evidence collection, serology, DNA analysis, 
fingerprint analysis, and chemical analysis of 
physical evidence. 
4 Credit Hours; 3 Lecture hours; 2 Lab hours 
 
Course Satisfies:  
Liberal Arts Elective, Open Elective, Science 
Elective 
Prerequisites/General Requirements:  College 
Reading, Basic Writing, and Basic Math. 
This course fulfills the Global Awareness, 
Public Presentation, and Science and 
Technology Core Intensive requirements at 
NECC.  
 

Required Materials 
●  Textbook:  Saferstein, Richard, 

Criminalistics: An Introduction to Forensic 

Science (12th edition).  
Prentice Hall, ISBN 978-
0134477596.  Old 
editions are also 
acceptable. 

●  Bound lab notebook 
●  Safety goggles for lab 
●  Scientific calculator  

Office Hours 
I will have the following office hours:    
Monday   9:15-10:15 am 
Haverhill E256 or TC219 
 
If you can’t make it to my office hours, let me 
know and we can arrange another time to meet.  
I may also be available before or after class.  
However, I may not always have enough time to 
spend with you if you try and talk to me before 
class.   

Attendance 
Regular attendance is expected for this course.  
Roll will be taken by a daily quiz.  No labs will be 
accepted from students who were not present 
for that day’s lab. You may be dropped for non-
attendance and/or for missing more than five 
class meetings.  Even though you may be 
dropped for non-attendance, if you withdraw 
from the course it is still your responsibility to 
submit an official drop card at the Office of 
Admissions and Records.  If you don’t, you may 
receive an F in the course.  
 
Responsibility for making up work missed 
and obtaining any information provided in 
class rests with you, the student. 

Timeliness 
It is important that you make 
it to class on time.  We have a 

Case Study 
The Use of Fiber Evidence: Wayne Williams 

 

 

Between 1979 and 1981 a series of brutal 
stranglings of young black men terrorized 
communities in Atlanta.  Twenty nine 
homicides were officially linked to the 
same killer, but police had little forensic 
evidence to track down the killer. 
Investigation of what became known as 
the “child murders” began on July 28, 
1979 when a woman discovered the 
bodies of 2 young men concealed in the 
undergrowth alongside a road. By 1981, 
nearly 20 young black males had been 
murdered by strangulation or 
asphyxiation.  Almost the only forensic 
evidence linking the killings were fibers 
found on the bodies and clothing of the 
victims.  The yellow‐green nylon fibers 
were unusual; coarse and tri-lobed in 
cross section the fibers appeared to be 
those used in rugs or carpets. However, 
police were unable to determine the 
manufacturer of the fibers.  

In February 1981, following newspaper 
accounts of the fiber analysis, the killer 

began dumping bodies in Chattahoochee 
River. The victims were now also nude, 
or nearly so. It appeared that the killer 
was monitoring media coverage of the 
killings, and modifying his methods to 
reduce fiber evidence on the victim’s 
bodies. Police began staking out bridges 
along the Chattahoochee River in an 
effort to catch the killer dumping a body. 
Early on the morning of May 22, 1981, a 
police patrol heard a splash. Police 
stopped a station wagon on the James 
Jackson Parkway Bridge. The driver was 
23 year old Wayne Bertram Williams, a 
music promoter. He was questioned by 
police, but allowed to leave. Two days 
later, the body of Nathaniel Cater was 
recovered from the Chattahoochee 
River, a mile downstream of the James 
Jackson Parkway Bridge.  

 

Police obtained a search warrant for 
Williams’ house. Throughout his house, 

The UDL Stipend Workshop— 
syllabus redesign
In the UDL workshop, computer science professor 
Kristen Sparrow redesigned her syllabus. Here 
are the before and after versions. Kristen is receiv-
ing a course release to work with Lance Hidy to 
develop UDL training materials for faculty and staff, 
fall 2019.

Biology Professor Michael Cross was also a partic-
ipant in the UDL stipend workshop. Here is a sylla-
bus and a case study that he redesigned with UDL 
principles.

Participants in the stipend workshop saw UDL 
design as a form of clear communication—related 
to using clear grammar and correct spelling. They 
spoke of it as a point of professional practice, and 
not as a workload issue to be required by a con-
tract. 

From these simple documents, the discussion 
then progressed to applying UDL to Blackboard.

This bottom-up approach is preferable to a 
top-down directive from the administration.

LIMITED UNIVERSAL
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The icon poster has created a sensation when 
presented at conferences at numerous colleges and 
universities, including Yale, UMass Amherst, 
Worcester State, and Bridgewater State.

The national accessibility conference in Colorado, 
Accessing Higher Ground, Nov. 2019, has invited 
Lance Hidy to give a 60-minute presentation about 
the story of the icon project and other UDL 
achievements at NECC.

It is unique. Nothing comparable exists in higher 
education, as far as we know. It is a powerful 
illustration of the effectiveness of images to 
increase engagement with readers, and of how UDL 
works. Faculty like it because their program is 
represented. They helped Hidy create the icons. 
One professor said it was the first time he had ever 
done that kind of visual thinking.

The registrar wants to make it an official docu-
ment that is updated every semester as majors are 
added, dropped, or renamed.

The recruiting team has found it effective at high 
schools. Students love it.

The Icon Project Other uses of the icons
Requests for icons, and for training on how to 
use them in Word, have come from all parts of 
the college, both from academic departments, 
and from student services.

ELLIOTT STREET              MAIN ENTRANCE
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The five academic centers—

1. Business & Accounting, 
2. Professional Studies, 
3. Liberal Arts, 
4. STEM, and 
5. Health Professions—
provide support for students 
in those disciplines.

A Bentley 
Library

B General 
Services

E Science 
Building

C Spurk

H AV E R H I LL    C A M PU S

TC Tech 
Center

SC Student 
Center

D Sport 
& Fitness 

Center

C

A

SC TC

B
E

D

STUDENT  
SUCCESS HUB 

• Academic Advising—SC 118
• Admissions—SC 104
• Book Store—SC 224
• Career Center—SC 209
• Civic Engagement &  

Service Learning—SC 211
• Counseling Center &  

Community Resources—SC 212–A & B
• Deaf & Hard of Hearing Services 

—SC 110
• Enrollment Services—SC 120
• Learning Accommodations Center 

—SC 111
• New Student Gateway—SC 104
• PACE Program, TRiO-SSS—SC 213
• Student Financial Services—SC 120
• Student Government—SC 216
• Student Life—SC 215
• Veterans & Military Services—SC 214 

Student Success 
Tutoring & Coaching

• Academic Coaching, C211
• Math & Science Tutoring, C205
• Writing & English Skills, C207

SC STUDENT CENTER

Business &
Accounting

Liberal Arts Health
Professions

Professional
Studies

STEM

STEM

HEALTH  
PROFESSIONS

PROFESSIONAL  
STUDIES

LIBERAL ARTS

THE STUDENT 
SUCCESS HUB

BUSINESS &  
ACCOUNTING

Wayfinding 
maps and 
signage

Pathway documents 
for careers and 
course sequences

Name tags for 
student orientation.

Librarians Susan 
Leonardi and Laura 
Mondt began creat-
ing pins for each of 
the six academic 
divisions. These will 
be given to incoming 
students to put on 
their backpacks.
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• In the blank line space below the title, place 
your cursor. In the Layout tab again, click on 
Breaks, and then choose “Continuous—Insert 
a section break and start a new section on 
the same page.” We’ll make the new section 
double column.

• Next, put your cursor in the first line of text 
following the title, go to the Columns icon, 
and choose Two. All of the following text 
should convert to two columns, but the title 
will stay across the top of the page, as a 
single column. You can use this technique to 
switch from two columns to single column, or 
even to three columns if you want. You just 
have to use the “Continuous” break feature to 
separate sections.

Using Quick Styles
The most important accessibility tool in Word is 
Quick Styles. This feature lets you assign styles to 
each category of heading, text, bullet lists, etc. 
These styles have two advantages:

• The styles add an invisible “Tag” to each type 
of text or heading. Style tags enable readers 
who are blind, and who use a screen-reader, 
to use “Skip Navigation” to jump from head-
ing to heading. Otherwise they would have 
to slowly go through text, losing time while 
searching for a section. Quick-style tagging of 

Graphic Design Basics in Word

By Lance Hidy & Kristen Sparrow, Aug 28, 2019

1. Margins
• In the Layout tab, choose the Margins icon,  

and then click on 
Custom Margins at 
the bottom of the 
menu.

• I recommend 
setting the top and 
sides at about .7” 
or .75”, and the 
bottom at about 
.9” or 1”. Half-inch 
margins are too 
small, and one-
inch margins look 
nice, but are more 
than you need, and can be wasteful of paper.

Columns—Single column and double 
column on the same page
The main title can be a single column that runs 
across the top of the page. The main content can 
be double column, which is easier to read, saves 
space, and gives more flexibility in arranging your 
content on the page. Double columns are espe-
cially useful when reading the document on the 
small screen of a smart phone. 
• Select Layout tab again, then click on the 

Columns icon. Choose the One column 
option.
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• There you will see the familiar fields for 
choosing font, size, style, colors, alignment, 
spacing, etc.

• Base Style on (no style) 

• Check “Add to Quick Style List” so that your 
custom style will appear in the 
Styles panel.

• The “Format” options button 
opens a menu with many 
additional ways to customize 
your style, including indents, 
adding space before or after, 
tabular numbers, etc.

• the headings and text will help your course 
materials go from the red to the green zone 
in the Blackboard Ally accessibility meter.

• Once you have applied Quick Styles through-
out your document, you can then make style 
changes globally, without having to do it 
manually. You can also automatically gener-
ate a table of contents.

Rather than use the default styles, it is recom-
mended that you manually modify the styles to 
suit your design taste. Here’s how—

Modifying (Customizing) a Quick Style
• First, open the Styles panel, and keep it open 

while you are styling your document.
• The button that opens the panel is a tiny 

arrow in the lower right corner of the Styles 
menu.

• Starting with 
“Normal,” which is 
the basic text style 
for your para-
graphs, right click 
on the style, and 
then click on 
“Modify.” That will 
bring up the 
“Modify Style” 
panel.
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Applying Quick Style
• Place your cursor into a title or a paragraph, 

and then click on the style in the Style Panel. 
This will apply the style to your text.

• If you only want to apply a style to a few 
words in a paragraph, select those words and 
then click the style.

Adding Pictures
• Place your cursor at the point where you 

would like to add the picture.
• From the “Insert” tab, choose “Pictures” and 

navigate to the picture you want.
• Click on the Layout Options button next to 

the picture.

• Choose a text wrapping option. The first or 
second ones, Square and Tight, are commonly 
used.

Adding Alt Text
Alt Text, or Alternative Text, is an invisible tag 
that explains a picture’s content to a person who 
is blind, and is using a screen reader. To pass 
Blackboard Ally’s accessibility check, and turn the 
meter from red to green, pictures must have alt 
text.

• Right click on the 
image to open the 
picture format menu.

• At the bottom of the 
menu click on Format 
Picture.  
 
This will open a panel 
to the right of your 
document with four 
icon tabs. 
 
 

• Click on the third icon. 

• Click on the Alt Text button, and then write 
your text in the Description panel.

Congratulations for Going Green!
• You have achieved basic accessibility compli-

ance with Quick Styles for text, and with Alt 
Text for images. These two things are neces-
sary to move your needle into the green zone 
for course documents that you post on 
Blackboard.
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After selecting 
Modify Style choose 
Borders option 
under format button 

Adding a Line Between Columns 
Step 1 – select More Columns. 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2 - in the next window check the Line Between 
Box. 

 

Toggling Paragraph Markers (¶) 
 

 

 

 

 

 

 

 

 

Adding Horizontal Lines to Quick 
Styles using Borders 
Step 1 – Modify Quick Style and Choose the Format 
Button 

 

 

 

 

 

 

 

Step 2 – Use the Border Option to add horizontal 
borders choose the Style and Width 

How to find Extra Spaces and 
Paragraph Returns! 
 

 

 

 

Choose 
Line 
Between 

Choose More Columns! 

Modify 
Style and 
Width 

On the Home menu choose the Paragraph 
Symbol ¶ to find extra spaces. The 
characters won’t show when printed 

After selecting 
Modify Style choose 
Borders option 
under format button 

Adding a Line Between Columns 
Step 1 – select More Columns. 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2 - in the next window check the Line Between 
Box. 

 

Toggling Paragraph Markers (¶) 
 

 

 

 

 

 

 

 

 

Adding Horizontal Lines to Quick 
Styles using Borders 
Step 1 – Modify Quick Style and Choose the Format 
Button 

 

 

 

 

 

 

 

Step 2 – Use the Border Option to add horizontal 
borders choose the Style and Width 

How to find Extra Spaces and 
Paragraph Returns! 
 

 

 

 

Choose 
Line 
Between 

Choose More Columns! 

Modify 
Style and 
Width 

On the Home menu choose the Paragraph 
Symbol ¶ to find extra spaces. The 
characters won’t show when printed 
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Demographics of Learning Abilities

403  
accommodations

1,119  
estimate 

undiagnosed

2,557  
estimate, fewer learning 

challenges, 50%

1,036
estimate, no 

accommodations

Spring 2017, estimated 1,439 NECC students (28% of 5,115)  
had documented disabilities in K-121

Only 403 registered with 
Learning Accommodations 
Center to seek accommo-
dations.

Estimated 1,036 
with documented 
disabilities attend 
classes without 
accommodations, 
undisclosed.

1,119 conservative 
estimate of students 
with undiagnosed 
learning challenges:
• Learning disability
• Illness
• Psychiatric
• PTSD 

& 
• Limited ESL 

vocabulary (not 
a disability)

1Source of estimating formula: 
Newman, L, Wagner M., Cameto, 
R., Knokey, A. (2009). The Post-high-
school outcomes of youth with disabil-
ities up to 4 years after high school: A 
report from the national longitudinal 
transition study-2. Washington, DC: 
National Center for Special Educa-
tion Research.

 Explanation of this estimating formula, from Robyn Hudson’s dissertation:

“…the exact number of students with disabilities in higher education remains unknown. 
Only 28% of students who received special education services in grades K-12 dis-
closed their disability to their postsecondary schools, and only 19% reported that 
they received any accommodations or supports in college (Newman et al., 2011, p. 
31). Students with disabilities who do not disclose to an institution’s disability services 
office generally do not receive any supports nor are they included in research studies.” 

—Robyn L. Hudson. The effect of disability disclosure on the graduation rates of college 
students with disabilities. 2013 dissertation,  Virginia Tech.

Mid-range learning disabilities, usually 
undiagnosed, benefit from Inclusive Design

Learning    disability spectrum

More extreme learning 
disabilities, often 
diagnosed


